
PROCEEDINGS OF THE 1st AAICE 2023 
Volume 1, Number 1, 2023, pp. xx-yy.  

FITK Universitas Alma Ata, Yogyakarta-Indonesia, September 16, 2023 
 

 Digital Transformation in Learning: Optimizing 

Computational Thinking Ability through Utilization of 

Geogebra 

Umi Khasanah1, Romadina Puspita Ratna2, Mahfudhotul Alfitriani3* 

1Department of Mathematics Education, Faculty of Tarbiyah And Teacher Training, 

Universitas Alma Ata, Indonesia 

2 Department of Mathematics Education, Faculty of Tarbiyah And Teacher Training, 

Universitas Alma Ata, Indonesia 

3 Department of Mathematics Education, Faculty of Tarbiyah And Teacher Training, 

Universitas Alma Ata, Indonesia 

*Correspondence: 211400130@almaata.ac.id 

*Correspondence: 211400140@almaata.ac.id 

*Correspondence: 211400150@almaata.ac.id 

Abstract. Educational activities in the information technology era have changed 

from time to time. These changes are both challenges and opportunities, especially 

in the educational process. So that changes that occur in the learning process require 

learning strategies in accordance with the development of information technology. 

There are several learning strategies that can be carried out in the digital era, 

including carrying out innovations and evaluations with digital GeoGebra media. 

The research method of writing this is a literature study of research results that have 

been published. This study aims to determine the effect of using GeoGebra in 

optimizing the ability to think computationally. Computational thinking skills are 

defined as mental activities to abstract problems and formulate solutions to these 

problems that can be automated. Based on the results of the research above, it can be 

concluded that students can work on questions by utilizing Geogebra Software 

seriously and enthusiastically in the learning process, and students can also find their 

own solutions to problems with the help of Geogebra software. 
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1.  INTRODUCTION 
The 21st century demands human resources to have many skills. One of the challenges is in the world 

of education to design or provide human resources capable of facing global competition. The Indonesian 

Ministry of Education and Culture in 2017 stated that there are four competencies that students in the 
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21st century must have called 4C, namely critical thinking and problem-solving (critical thinking and 

solving problems), creativity (creativity), communication skills (ability to communicate) and ability to 

work collaboratively (ability to work together).[1] Thus, the purpose of 21st-century education is not 

only to prepare simple students but to produce students who have these four competencies. Based on the 

explanation above, critical thinking and problem-solving (critical thinking and solving problems) are 

one of the abilities that must be mastered by students. 

     In everyday life, it often happens that learning still looks monotonous and does not lead students to 

think critically. In learning mathematics for example. Meanwhile, in learning mathematics students 

should be trained to think critically and be able to solve problems. This is because learning mathematics 

is one aspect of education that has an important role in shaping one's thinking skills and logical skills. 

The application of procedural learning techniques results in students not being able to understand the 

concept properly. PISA (Program for International Student Assessment) is one of the main assessments 

on an international scale that assesses students' mathematical abilities.[2] The 2018 PISA survey 

assessed 600,000 students aged 15 from 79 countries. Based on the survey, it was found that the 

mathematical ability of Indonesian students was 379, ranking 7th from the bottom, while the average 

OECD member country for mathematics and science was 489.[3] The acquisition of this value shows 

that the mathematical abilities of Indonesian students are very low. That means the ability and 

application of mathematical communication, problem-solving, and reasoning of Indonesian students are 

still not optimal.[4] So by looking at the results of the PISA, Indonesia is required to reflect and improve 

itself in order to improve the mathematical abilities of students in Indonesia.[5,6] 

     Soedjadi argues that the basic objects of mathematics are facts, concepts, relations/operations, and 

principles which are abstract things so understanding them is not enough just to memorize but requires 

a thought process.[7,8] Meanwhile, Santrock states that the process of thinking is manipulating or 

managing and transforming information in memory. Thus, learning mathematics should emphasize the 

thinking process of students so that they can get used to processing and transforming information to 

solve a problem. Therefore, students' thinking abilities become one of the benchmarks for achieving 

mathematics learning objectives, for example, such as high-order thinking skills, critical thinking skills, 

creative, computational, logical-analytic, and reflective.[9,10] 

     One of the thinking skills that must be mastered by students is the ability to think computationally 

(computational thinking). Computational thinking is a cognitive skill that allows educators to identify 

patterns, solve complex problems into small steps, organize and create a series of steps to provide 

solutions and build data representations through simulation.[11] Computational thinking techniques are 

very important to master in learning mathematics because it trains to be able to solve problems and find 

solutions. Not only in learning mathematics but computational thinking skills are also needed in the 

world of work. As Wing argues, computational thinking is not only important for those who want to 

pursue a career in technology or computing but can also help someone in a variety of other fields.[12,13] 

     Computational thinking techniques according to Ioannidou (2011: 4) can be described as follows: 

decomposition, pattern recognition, pattern and abstract generalization, and algorithm design. 

Decomposition is the ability to break down complex tasks (problems) into small, more detailed tasks 

(problems). Pattern recognition is the ability to recognize common similarities or differences in order to 

make predictions, for example, to recognize number patterns. Pattern generalization and abstraction are 

the ability to filter out unnecessary information and draw generalizations based on the information 

received so that these results can be used to solve similar problems. Algorithm design is the ability to 

arrange the stages of problem-solving.[14] 

     As is often seen, learning mathematics in schools still uses procedural learning methods. And this is 

not effective in motivating water students to be able to identify and solve problems. In this case, there 

is one medium that can help students improve their computational thinking skills, namely the GeoGebra 

application. According to Ekawati (2016), GeoGebra is a dynamic mathematical software that combines 

geometry, algebra, and calculus. Hohenwarter & Fuchs (Nopiyani, Turmudi, and Prabawanto, 2016) 

said that GeoGebra is very useful as 1) demonstration and visualization media; 2) construction tools; 3) 

discovery process aids; and 4) means of communication and representation.[15] 
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     One example of mathematics learning material that can be solved using GeoGebra is spatial 

geometry. GeoGebra was developed in 2008-2009 at Florida Atlantic University by Markus 

Howenwater. GeoGebra is a multi-representational application, which has an algebraic display, a 

graphical display, and a numerical display, according to Nur (2016).[16] This is in line with Shandy 

Agung (2018) stating that GeoGebra is a computer software that can visualize mathematical objects 

quickly, accurately, and efficiently. By using this GeoGebra application, students are able to visualize 

mathematical concepts to become more concrete and motivate students to be able to identify and solve 

problems in learning mathematics. 

     Based on the description above, the reason researchers raised this problem was in an effort to improve 

students' computational thinking abilities by using GeoGebra applications on linear equation material. 

For the formulation of the problem, how effective is the use of GeoGebra media in increasing students' 

computational thinking skills in learning mathematics? What are the challenges or obstacles that might 

be faced in using GeoGebra in learning to optimize students' computational thinking skills? 

 

2.  METHOD 
The research method of writing this is a literary study of research results that have been published in 

national and international journals. A literature study is a series of activities related to methods of 

collecting library data, reading and taking notes, and managing research materials, involving systematic 

steps to collect, evaluate, and synthesize information from various literary sources relevant to the 

research topic. 

     Another understanding of the study of literature is to look for theoretical references that are relevant 

to the cases or problems found. These references can be searched from books, journals, and research 

report articles. The output of the literature study is the collection of references that are relevant to the 

formulation of the problem. The results of the research study regarding the ability to think 

computationally by utilizing GeoGebra during 2013-2023. 

     After collecting several related journals, then analyzing the data using descriptive qualitative analysis 

through literature study, the results of the analysis are in the form of descriptive data in the form of 

written sentences and the observed behavior results from the results of research conducted by previous 

researchers.[13] 

     This study aims to determine the effect of using GeoGebra in optimizing the ability to think 

computationally by reciting, recording, and managing journals that are relevant to GeoGebra and 

computational thinking skills as well as journals that show the effect of learning with the use of 

GeoGebra in improving computational thinking skills. 

 

3.  RESULT AND DISCUSSION 
 

This article is written to see and provide examples of the application of mathematical computational 

thinking in geometric material using GeoGebra media. The author presents a brief explanation of the 

geometry to be discussed, namely the tube. And the elaboration of other points that will be discussed 

such as computational thinking, computational thinking indicators, and GeoGebra. Apart from the 

elaboration of the points mentioned above, the results will explain how effective the use of the GeoGebra 

application can improve students' mathematical computational thinking skills as well as the challenges 

or obstacles that may be encountered in using the GeoGebra application. 

 

3.1.  Result 

Use of GeoGebra in spatial geometry 
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In this article, the researcher will provide an example of using the GeoGebra application in space 

geometry material in finding the volume of a cylinder. 

The tube is a geometric shape that has curved sides and consists of 3 sides and two ribs. The side planes 

on the tube are located on the base or bottom of the tube which consists of 1 side and 1 more side located 

on the curved plane of the tube space. It turns out that the curved plane in the tube is often known as the 

tube blanket because it covers the "body" of the tube. One more thing, the side of the tube is located at 

the top of the tube or more commonly known as the tube cover. 

The volume in the cylinder shape can be calculated by the following formula 

V = Base area x height 

V = 𝜋 x r2 x t 

Here's how to draw a tube using GeoGebra: 

1. Type A (0,0,0) and B (0,0,5) on the input menu display. Then, click the menu to the right, dot 

three, and click 3D Graphics. 

 

2. Next a display will appear as below. 
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3. In the two-dimensional graphics section, click ''slider'' and input as shown below 

 

4. On the three-dimensional graph, click the ''cylinder'' menu. 

 

5. Next, cl ick point A to point B and name it r. 
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6. And it will look like the following. 

 

7. Click the slider on the two-dimensional graph and input the numbers as below 
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8. Input C = (0, 0, h) 

9. On the three-dimensional graph, click the 'cylinder' menu again and name it r. 

 

10. And the tube image has been formed. 
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An example of applying the volume of a cube to GeoGebra: 

If it is known that the radius of the tube is 3 cm and the height of the tube is 5 cm. Determine 

the volume of the tube! 

To find out the volume of the cylinder, we only need to shift the points r and h at the point asked 

for the question. And the volume of the tube will appear, which is 141.37 cm. 

 

Achievement indicators think computationally in using the GeoGebra application to find the volume of 

a cylinder. 

1. Decomposition 

To solve a math problem, the first thing to do is to read and understand the problems that arise 

in the questions. In this case, students must simplify the problem into small parts that are easy 

to understand.[17] 
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If it is known that the radius of the tube is 3 cm and the height of the tube is 5 cm. Determine 

the volume of the tube! 

In the example problem above, students are able to read that the radius of the tube or which can 

be symbolized by r which is mentioned in the problem is 3 cm and the height of the tube which 

can be symbolized by t is 5 cm. And students are asked to find the volume of the cylinder. 

This first step is the decomposition stage, where students make center points at A (0,0,0) and B 

(0,0,5) on the input menu display. Then, click the menu to the right, dot three, and click 3D 

graphics 

 

 

2. Pattern recognition 

In this indicator, students are expected to be able to develop and understand the pattern for 

the steps to be used.[17] With the same example problem, students can understand how to 

find the volume of a cylinder, the radius, and the height of the tube are needed. 

In the third step of using GeoGebra, in the maximum menu, enter 5 because the height 

requested for the question is 5. 
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3. Thinking Algorithm 

This relates to algorithmic thinking skills by making it easier for students to analyze and 

prepare steps to solve problems.[17] 
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At this step, students have thought of an algorithm and will make it easier for the next step. 

4. Generalization of Patterns and Abstractions 

Students can use fast ways to solve problems based on previously obtained data. In line with 

the statement (Cahdriyana & Richardo, 2020) which states that the pattern recognition 

section is useful for strengthening ideas on abstraction indicators. [17] 

 

When the concept has been formed, students only need to adjust the size of the radius and 

height of the tube asked for by the question. Automatically the cylinder volume will 

immediately appear on the application screen display 

       The results of relevant research state that teachers feel helped by the software because students can 

learn independently easily not only at school but also at their respective homes. By increasing student 

learning motivation, teachers feel more optimistic about improving student learning outcomes. 

       Based on research conducted by Dara Kartika Dewi, et al (2020) with mathematics learning assisted 

by the GeoGebra application on Geometry Transformation material, it was concluded that students were 
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interested in learning indicators and almost all students had positive responses. enthusiastic. In addition, 

it is easy to access the GeoGebra software, namely via a computer or smartphone so that it can be used 

easily anywhere and anytime. Broadly speaking, students and teachers have no difficulties and feel 

helped with the help of the GeoGebra software.[18] 

The advantages of GeoGebra are (1) being able to visualize objects so that students can reduce the level 

of abstraction on a material, (2) GeoGebra can be used as an aid in solving math problems, math learning 

media, and tools in making teaching materials mathematics. (3) easy and free access, (4) easy to analyze 

the characteristics that exist in something geometric objects, and (5) the existence of animation and 

manipulation movements that provide visual impact on students so that students are able to understand 

the concept of geometry clearly. Weakness GeoGebra is not all math material can be applied in 

GeoGebra and for to use GeoGebra must have a device (computer or smartphone).[19] 

Based on research conducted by Muhammad Rizaldi Juliansyah in his thesis entitled, Computational 

Thinking of Students based on Gender with the AIR Learning Model assisted by GeoGebra by taking 

questionnaire data from 15 respondents randomly there are indicators of the effectiveness of GeoGebra, 

namely as follows; 

1. Cognitive aspects 

a. Problems can be solved 

Based on the results of his research, by using GeoGebra students are able to solve problems efficiently 

because it doesn't take a long time to solve problems percentage of 74.45%. 

b. Retention of material 

GeoGebra itself is able to visualize objects, symbols, and equations in material mathematics clearly 

(Umayah & Evendi, 2018). And the results of his research, as much 68.89% of students are able to 

understand the material well. 

c. Feelings of joy following learning 

By using a response questionnaire in his research, it turns out that GeoGebra can increase students' 

interest in learning mathematics by a percentage of 77.08%. 

2. Material aspects 

a. Media can explain the material 

GeoGebra can provide illustrations of geometric objects (tubes, cones, and balls) on the material studied 

in class, namely the material of curved side shapes. GeoGebra can also solve for the surface area and 

volume of shapes with enter the formula into the input. Thus, the presentation of GeoGebra in explaining 

matter is 83.33%. 

b. Compatibility with the material 

Curved side shape materials can be applied to GeoGebra media. So the suitability of the material can 

help students to understand the material being studied. The indicator of the suitability of the media with 

the material gets a percentage of 71.11%. 

c. Learning is more interesting 

Learning that is not monotonous can increase students' interest and motivation in learning learn math. 

This indicator gets a percentage of 71.67%. 

3. Media aspect 

a. Animation display quality 

GeoGebra can clearly visualize objects, symbols, and mathematical equations and can reduce the level 

of abstraction in mathematical material. In this case, GeoGebra can help students improve the learning 

process. The percentage reached 72.78%. 

b. Easy to operate 

GeoGebra can be accessed online through the website or offline with download the app. The percentage 

reaches 70%. 

c. Caption readability 
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GeoGebra provides users with visualizations to display objects clearly and realistically. The objects 

displayed by GeoGebra can help students understand curved side building materials, especially what are 

the characteristics contained in each geometric shape such as a cylinder, cone, and cylinder. This 

indicator gains a percentage of 76.11%.[19] 

 

3.2.  Discussion 

 

 

Think computing 

       Computational thinking is a cognitive skill that allows educators to identify patterns, solve complex 

problems into small steps, organize and create a series of steps to provide solutions and build data 

representations through simulation. [7] Computational thinking is a way for someone to formulate a 

problem by breaking down the problem into smaller and more manageable parts, in other words, 

computational thinking is a series of activities that involve a set of skills and techniques to solve 

problems.[20] Based on this understanding of computational thinking, it can be seen how important this 

ability is to face 21st-century life which focuses on the digital role. Therefore, this ability should be built 

by students as early as possible through formal education. 

       Computational thinking skills are defined as mental activities to abstract problems and formulate 

solutions to these problems that can be automated. Society's life is currently based on digital information, 

therefore the ability to think computationally is an important ability for everyone. To ensure that students 

are able to master these skills, it is important for teachers to incorporate them into the learning process 

at school. 

       Lockwood & Mooney (2017:15) states that integrating computational thinking in the education 

sector provides benefits including 1) improving analytical thinking skills students, 2) enabling students 

to have a better understanding of programming, that the goal is solving the problem and not just about 

the code, 3) fixing the views students about programming and encourage their self-confidence, 4) can 

be used as a clear indicator of academic success, this is because the computational thinking score has 

strong correlation with general academic success.[21] 

 

Computing thinking indicator 

       Indicators of computational thinking skills refer to 4 aspects of computational thinking skills, 

namely 1) problem decomposition, 2) algorithmic thinking, 3) pattern recognition, and 4) abstraction 

and generalization.[22] 

Indicators of computational thinking skills (Cahdriyana & Richardo, 2020), which include: 

Computational Thinking 

Skills 

Indicator 

Decomposition Students are given information on how to simplify a problem by 

dividing it into parts that are easy to understand. 

Pattern recognition Students are directed to be able to develop and understand the pattern 

for the steps to be used. 

Algorithmic Thinking This relates to algorithmic thinking skills by making it easier for 

students to analyze and prepare steps to solve problems. 

Generalization of Patterns and 

Abstractions 

students are advised to be able to use a fast way to solve problems 

based on data obtained previously. 

 

 

GeoGebra 

GeoGebra is a freely accessible mathematical software that is quite complete and can be used to solve 

geometry, algebra, and calculus problems (Haciomeroglu, Bu, Schoen, & Hohenwarter, 2009). 

GeoGebra was first developed by Markus Hohenwarter from Austria and the name GeoGebra is an 



 
THE 1st AAICE 2023  ISBN: XXX-XXX-YYY-YY-Z 
 
 

abbreviation of geometry (geometry) and algebra (algebra) (Tamimuddin & Nurul, 2013). The 

advantages of the GeoGebra application as quoted in Fazar (2015) include: easy to use, quite complete 

features for learning mathematics, supports web platforms, supports various operating systems, is 

available in various languages, is open source, and is free. According to Hohenwarter & Fuchs (2004), 

GeoGebra is very useful as a medium for learning mathematics with a variety of activities as follows. 

1. As a demonstration and visualization medium. In this case, in traditional learning, teachers use 

GeoGebra to demonstrate and visualize certain mathematical concepts. 

2. As a construction aid in this case GeoGebra is used to visualize the construction of certain 

mathematical concepts, for example constructing the inner circle or outer circle of a triangle, or a tangent 

line. 

3. As a tool for the discovery process in this case GeoGebra is used as a tool for students to find a 

mathematical concept, for example, the position of dots or the graphical characteristics of a 

parabola.[23] 

 

The use of GeoGebra should be utilized to support self-learning processes because the features provided 

by GeoGebra are quite complete, it's just how teachers can make media and mix them in the learning 

process. 

       The main menus of GeoGebra are File, Edit, View, Options, Tools, Windows, and Help for drawing 

geometric objects. The File menu is used to create, open, save, and export files, as well as exit programs. 

The Edit menu is used to edit paintings. The View menu is used to set the view. The Options menu is 

for adjusting various display features, such as setting font size, setting the type (style) of geometric 

objects, and so on. Meanwhile, the Help menu provides technical instructions for using the GeoGebra 

program.[23] 

 

1. CONCLUSION 
 

Based on the results of the research above, it can be concluded that students can work on questions by 

utilizing GeoGebra Software seriously and enthusiastically in the learning process, and students can also 

find their own solutions to problems with the help of GeoGebra software. Information was obtained that 

they felt happy and helped by the GeoGebra Software in solving spatial geometry problems. In addition, 

it is easy to access the GeoGebra software, namely via a computer or smartphone so that it can be used 

easily anywhere and anytime. In general, students and teachers experience no difficulties and feel helped 

by the help of the GeoGebra software. As well as students can also find their own solutions to problems 

with the help of GeoGebra software which can optimize students' computational thinking. 

 

REFERENCES 
[1] Partono, dkk,.‘’Strategi Meningkatkan Kompetensi 4C (Critical Thinking, Creativity, 

Communication, & Collaborative)’’. Jurnal Penelitian Ilmu Pendidikan, 14 (1), (2021) 41-52 

[2] Mansur, N. (2018). Melatih Literasi Matematika Siswa dengan Soal PISA. Prisma, 1, 140–144.  

[3] Schleicher, A. (2019). PISA 2018: Insights and Interpretations. OECD, 3–62. 

[4] Annizar, A. M. (2015). Analisis Kemampuan Pemecahan Masalah Soal PISA Menggunakan 

Model IDEAL Pada Siswa Usia 15 Tahun di SMA Nuris Jember. 

[5] Annizar, A. M., Sisworo, & Sudirman. (2018). Pemecahan Masalah menggunakan Model IDEAL 

pada Siswa Kelas X Berkategori Fast-Accurate. Jurnal Pendidikan: Teori, Penelitian, Dan 

Pengembangan, 3(5), 634–640. 

[6] Lestari, Ayu Chinintya. dkk,. ‘’Proses Berpikir Kritis Siswa Dalam Menyelesaikan Masalah PISA 

ditinjau dari Kemampuan Berpikir Komputasi’’. Jurnal Kiprah. 8 (1) (2020) 46-55 

[7] Soedjadi. 2000. Kiat Pendidikan Matematika di Indonesia. Jakarta: Direktorat Jendral Pendidikan 



 
THE 1st AAICE 2023  ISBN: XXX-XXX-YYY-YY-Z 
 
 

Tinggi, Departemen Pendidikan Nasional. 

[8] Danindra, Lintang Sekar. ‘’Proses Berpikir Komputasi Siswa SMP dalam Memecahkan Masalah 

Pola Bilangan Ditinjau Dari Perbedaan Jenis Kelamin’’. Jurnal Ilmiah Pendidikan 

Matematika. 9(1). (2020) 96 

[9] Santrock, J. W. 2009. Psikologi Pendidikan Edisi 3: Jakarta: Salemba Humanika. 

[10] Munawaroh, Lailatul, dkk,. “Penggunaan Jurnal Belajar Dalam Pembelajaran Class Wide Peer 

Tutoring Terhadap Kemampuan Berpikir Kritis Siswa”. Jurnal Pendidikan Biologi Indonesia, 

1(3), (2015) 263-273. 

[11] Fathur Rachim (2015), Computational Thinking = Computer Science ++, Kompasiana, 

https://www.kompasiana.com/fathur_rachim/55e06cc71593736c0a109023/computational-

thinking-computerscience?page=all (diakses pada tanggal 28 Juli 2023). 

[12] Wing, J. M. (2008). Computational thinking and thinking about computing. Philosophical 

Transactions of the Royal Society A: Mathematical, Physical and Engineering Sciences, 

366(1881), 3717–3725. 

[13] Christi, Sabinus R. N., & Rajiman, W. “Pentingnya Berfikir Komputasional dalam Pembelajaran 

Matematika”. Journal on Education, 05(04), (2023) 12590-12598. 

[14] Maksum, Khanif. dkk., ‘’Pengembangan Instrumen Tes Keterampilan Berpikir Komputasi pada 

Pelajaran Matematika Sekolah Dasar (SD) / Madrasah Ibtida’iyah (MI)’’. Modeling : Jurnal 

Program Studi PGMI. 9(1), (2022) 42-43. 

[15] Telaumbanua, Yakin Niat. ‘’Analisis Pembelajaran dengan Menggunakan Software Geogebra 

dalam Pembelajaran Matematika’’. J-PiMat. 2(1), (2020) 

[16] Dewi, Kartika Dara, dkk,. ‘’Analisis Motivasi Belajar Matematika Siswa SMA Bingkai Cendikia 

Cililin Berbantuan Aplikasia Geogebra pada Materi Transformasi Geometri’’. Jurnal 

Pembelajaran Matematika Inovatif.3(1) (2020) 

[17] Jamalludin, dkk., ‘’Analisis Keterampilan Berpikir Komputasi Peserta Didik SMP Berbasis 

Pondok Pesantren pada Pembelajaran IPA’’. Jurnal Pendidikan MIPA, 12(2), (2022) 267-268. 

[18] Faizah, Hanim. dkk,. ‘’ Efektivitas Lembar Kerja Siswa (LKS) Berbantuan Softwware Geogebra 

pada Materi Program Linear’’. Jurnal Pendidikan Matematika dan Matematika. 3 (2), (2017) 

103-110. 

[19] Rizaldi Juliansyah, Muhammad,. ‘’Laporan Skripsi: Computational Thinking Siswa berdasarkan 

Gender dengan Model Pembelajaran AIR Berbantuan GeoGebra’’. (2022) 

[20] Mufidah, I. (2018). Profil Berpikir Komputasi Dalam Menyelesaikan Bebras Task Ditinju Dari 

Kecerdasan Logis Matematis Siswa. Universitas Islam Negeri Sunan Ampel Surabaya. 

Retrieved from http://digilib.uinsby.ac.id/28697/8/Imro atul Mufidah_D94214100.pdf 

[21] Danoebroto, Sri Wulandari. Choirul Listiani,. ‘’Analisis Berpikir Komputasi Guru Sekolah Dasar 

dalam Menyelesaikan Masalah terkait Skala’’ (Computational Thinking Analysis of 

Elementary School Teacher in Solving Problem Related to Scale). 

[22] Cahdriyana, R. A., & Richardo, R. ‘’Berpikir Komputasi Dalam Pembelajaran Matematika’’. 

LITERASI (Jurnal Ilmu Pendidikan), 11(1),(2020) 52 

[23] Asngari, Dian Romadhoni. ‘’Penggunaan Geogebra dalam Pembelajaran Geometri’’. Seminar 

Nasional Matematika dan Pendidikan Matematika UNY. (2015). 


